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Preface
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otherwise tedious aspect of desktop publishing. MathWriter meets our needs, and we hope 
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full screen editor

Wysiwyg

user interface

MathWriter™ is an intelligent full screen editor for 
mathematical typesetting. Unlike conventional word 
processors that deal with a one dimensional stream of 
characters on each line of text, MathWriter handles the 
two-dimensional characteristic of mathematical equations 
and offers you convenient access to a much larger 
collection of fonts, font styles, font sizes, and special 
mathematical symbols needed to write equations. 
Mathwriter automatically and interactively handles many 
typographic conventions such as placement of multiple 
levels of subscripts; placement and sizing of fraction bars; 
placement and sizing of the limits of integration; and 
stretching of brackets, braces, and parentheses to 
correspond to the size of their contents.

Mathwriter is a “what you see is what you get” editor. 
What you see on the screen as you type is what you get 
when you print the equation. You do not have to memorize 
a large collection of embedded commands that the 
program later converts into a screen display or printed 
output. The mouse and the user-customized palette on the 
screen permit you to compose even the most complex 
mathematical expressions with almost no use of 
memorized keystroke combinations. Simply point-and- 
click. This feature dramatically reduces the time required 
to master and to use this program!

MathWriter follows the Macintosh™ User Interface
conventions. A Macintosh user already familiar with 
programs such as MacWrite™, MacPaint™, MacDraw™, or 
Microsoft Word™ will be comfortable with the familiar 
style of MathWriter™. Editing by pointing and dragging 
plus the “cut”, “copy”, and “paste” capabilities of MacWrite 
or Word™ appear the same. The single characters in 
MacWrite may in MathWriter be a complex vertical
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structure such as a fraction bar with numerator and 
denominator, yet you can select, modify, and “cut and 
paste” these vertical components. You can even change 
fonts, font sizes, font styles, and special mathematical 
formatting preferences for existing text that you select by 
dragging the cursor.

output The program fully supports both ImageWriter™ and 
LaserWriter™ printed output with 72 and 300 dots per 
inch resolution respectively. The presently available Laser 
fonts are underlined in the menu listing for convenient 
identification. MathWriter stores the text internally in an 
expandable object form; therefore, the print resolution is 
limited only by the output device. The same file that 
produces a printed page on an ImageWriter can be used 
with Allied Linotype’s Linotron that can produce 2570 dots 
per inch.

data storage

jxitx 

MV file

External storage of data in a MathWriter file allows you 
to retrieve and modify equations at a later time. You can 
store multiple equations in each MathWriter file. Each 
equation has its own vertical and horizontal tab 
information and font environment. Alternatively, you can 
internally convert each equation and store it on diskette in 
MacPaint and MacDraw (PICT) files to modify later with 
those programs; for example, you can place a box around 
an equation for emphasis. From these files you can 
transfer equations to page layout programs such as 
PageMaker™, or you can transfer them directly into these 
or other applications through the standard Clipboard. 
Switcher™, included with the program, allows immediate 
switching between different applications. You can compose 
equations as needed and immediately paste them into 
MacWrite or Word, or you can prepare many equations at
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once and retrieve them as needed. MathWriter has a 
virtual memory scheme that allows you to handle files of 
equations larger than will fit in memoiy with only a slight 
delay for disk access.

style MathWriter is flexible enough to deal with such stylistic 
matters as bracket overhang, subscript and superscript 
placement, spacing around the fraction bar, and the row 
and column spacing of elements within a matrix.

MathWriter™

You can
• locally lengthen or shorten parts of an expression.
• lengthen or shorten spacing between words to justify a 

line of text mixed with equations with a ruler in a word 
processor.

• arbitrarily increase or decrease the height of individual 
symbols.

• center matrices on a line or lower them below the line.
• align the rows in separate matrices with one another.
• vertically stretch or shrink certain symbols such as the 

integral symbol or the absolute value symbol as an over
ride to the automatic sizing.

• stretch or shrink the equation to fit the available space 
while maintaining the width-to-height ratio even after 
you paste an equation into a MacWrite, Word, or 
WriteNow document.

[D] =
E (1-M.)

(i-n0(i-2n)

1 JL
i-ft

0

1-|X
l 0

M- ii 0
1 -p i-ii
0 0 1-2 n
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Further, more complex placement of characters is
possible. For example, with an overlay screen you can 
manually handle superposition of multiple characters for 
closed contour integral symbols or for programming 
languages such as APL. You have the full complement of 
diacritical marks in a Laser font and an optional manual 
adjustment of vertical placement.

MathWriter offers numerous typing aids. The most 
significant is the on-screen palette menu that includes the 
Greek alphabet and some of the most common 
mathematical structures. You can interactively add to the 
on-screen palette from the pull-down palette menu a 
user-selected alphabet and any of the symbols in the 
Symbol™ LaserWriter™ font plus a few unique additions. 
This user-defined palette menu minimizes screen clutter 
by allowing you to transfer into the on-screen palette only 
those character groups you use most often. From a special 
pull-down menu you can click-type the trigonometric and 
hyperbolic function names.

The placement of a numerals palette on-screen enables 
you to create and recall rapidly up to ten user-defined 
expressions called “library scraps”. When used with the 
Option and Command (§€) keys on the keyboard, the 
numerals entry palette provides access to these user- 
defined “library scraps”. Thus for quick pasting into 
expressions you can create frequently used groups of 
symbols as user-defined macros.
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MathWriter™  
U ser’s Guide

2.1 A  QUICK  START

2.1.1
Macintosh
Conventions

The User’s Guide consists of two parts: a quick start 
introduction which you should read before you begin use 
of the program and a more extensive guide to the operation 
of MathWriter which should give you a familiarity with 
all of MathWriter’s powerful features. Chapter Three 
provides a detailed description of each tool for reference. 
We urge you to read the reference material at least once.

We assume that you are familiar with the Macintosh 
computer and either the MacWrite™ or Microsoft Word™ 
word processor. This User’s Guide presumes such 
experience as background! (Experience with MacPaint, 
FullPaint, MacDraw, or MacDraft is useful but not a 
prerequisite for effective use of MathWriter.) While 
MathWriter can be a stand-alone application, it is more 
useful when used in combination with a word processor 
and Switcher™. Switcher is included with the master 
(distribution) diskette.

Throughout MathWriter we have adhered faithfully to the 
Macintosh User Interface. This allows you to concentrate 
more comfortably on the content of your work rather than 
on the vehicle used to produce the mathematical typeset
ting. As you type, the program continuously updates the 
displayed mathematical structures.

Flexibility is another feature of MathWriter. Multiple 
paths through the typesetting process allow you to proceed 
in the most comfortable and intuitive manner possible. At 
any stage all permissible options in a menu appear in 
normal print while non-permissible options appear 
dimmed and disabled.

In the discussion that follows we briefly review some of 
the most important Macintosh topics. The basic
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Select Then 
Issue Command

Cursor Shape

assumption of the Macintosh interface is that language- 
independent pictures are a more convenient means of 
communicating than words. The use of pictures is 
facilitated by the “mouse” pointing device. Consequently, 
the central paradigm for the Macintosh is for you to 
select an object by pointing and then issue an action 
instruction fo r the selected object. Remember this and 
your mastery of this application will come more quickly.

Regard your Macintosh screen as an electronic 
representation of your desktop. You can rearrange the 
items on the screen with three basic actions of the mouse:

1) clicking — Position the pointer (of whatever shape) to 
the desired location by moving the mouse, and then 
briefly press and release the mouse button without moving 
the mouse. Double-clicking in quick succession extends 
the action of the first click, e.g. to select and open a file.

2) pressing — After positioning the pointer, hold down the 
mouse button without moving the mouse.

3) dragging — Position the pointer, hold down the mouse 
button while moving the mouse to a new location, and 
release the button.

The cursor shape changes according to its function. An 
arrow is the most common shape and is used to press the 
scroll bars, the close box, etc. An I-beam pointer indicates 
the placement of text entered from the keyboard. A tiny 
“point” or dot cursor is used for very precise placement of 
the insertion point in a complex equation. A wrist watch 
pointer indicates that a time-consuming operation is in 
progress.
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Select

2.1.2
Backup Copy

You must select an object before you can perform an 
operation on it, but selection itself has no effect on the 
object and can be undone without side effects. Simply 
place the cursor on an object and click to select. Double 
clicking (clicking twice in succession without moving the 
mouse) extends the effect of a single click. For example, 
double clicking on an icon not only selects that item but 
also instructs the program to run or execute that item 
from the Finder.

You can select text and numeric entries by dragging.
Simply place the pointer and click the mouse to fix the 
insertion point. The I-beam pointer automatically 
appears enabling you to insert characters. To remove 
characters, select them by dragging and press Backspace 
or begin typing to delete the selected material and insert 
new characters.

If the preceding was not a review, study your owner’s guide 
and word processor manual. Review techniques for using 
the mouse, selecting and choosing, manipulating win
dows, using an application, and organizing documents.

In this User’s Guide the general instructions are in 
boldface text, and the detailed step-by-step procedures are 
preceded by a bullet (•). The names of pull-down menus are 
shown in bold, the names of options on these menus are 
shown in italic, and the names of keys to be pressed are 
shown with leading capital and italicized. Buttons and 
menu choices are shown in capitals and italicized.

Make a backup (working) copy of the distribution diskette 
immediately and add a copy of your word processor 
program to this working disk if double-sided (800K) or to a 
separate data disk if single-sided (400K).
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• Secure the write-protect tab of the master distribution 
disk to prevent accidental erasure and locate an erasable 
diskette to become the working disk.

The working diskette should not be write-protected 
during the copy process or during actual usage. You 
can use up to 80K of the program disk space for 
temporary storage.

• Copy the entire locked master MathWriter diskette 
(System folder, MathWriter, and Switcher) to your 
working disk using the standard techniques.

To do this start your Macintosh and place your locked 
MathWriter disk in the internal drive. When the 
MathWriter diskette icon appears on the desktop, place 
the blank, destination diskette for the working copy in the 
external drive. [See “ copying, disk” in your owner’s 
manual if you are copying with a single drive.] If you have 
not previously used the destination disk, select Initialize 
and when requested supply a unique name (e.g., MW 
9/1/86) for the working disk. On the other hand, if your 
destination disk has been used and contains other 
programs, either transfer these programs to another disk 
or erase the disk using the Erase option on the pull-down 
Special menu.

To start the copy process drag the master distribution disk 
icon to overlap the working disk icon. The master is NOT 
copy protected and requires no special procedures. When 
the copying is complete, use the Shut down option under 
the Special pull - down menu.

Now store the master disk in a safe place and place the 
working disk in the internal drive.
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2.1.3
Introductory
Examples

• Although not necessary for this quick introduction, 
transfer a copy of your word processor (e.g., MacWrite, 
Word, or WriteNow) to the working disk if it is double
sided (800K) or to a separate data disk if you are using 
single-sided disks.

If using double-sided disks place your word processor disk 
in the external drive. When the disk icon appears, click 
on it to open it. Then drag your word processor’s icon onto 
the working disk. Eject the word processor disk using 
Eject on the File menu or alternatively use Xshift 2 (i.e., 
press and hold down the command (§€) and shift keys 
while you press the numeral 2 ). With single-sided disks, 
the word processor and your data files will normally be 
in the external drive.

Activate the MathWriter application

• Open the MathWriter (working copy) disk by clicking on 
its icon.

The files on this disk are now displayed on the desktop.

• Double click the MathWriter icon (or click once on the 
MathWriter icon and then select Open from the File 
menu).

MathWriter™

You use a slightly different procedure in the next section 
when you use Switcher to place both MathWriter and your 
word processor in memory at the same time. That 
additional complexity is not necessary for this quick tour.
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The following screen is now present.
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Explore some of the commands

• Pull down the ft menu, drag the cursor to About 
MathWriter™, and release the mouse button to see the 
copyright notice and MathWriter version number.

• Click anywhere within the banner to resume.

Produce the following three simple equations using the 
commands at the top left of the MathWriter screen. These 
examples show the basics of equation writing with 
MathWriter.



USER'S GUIDE
17

Example 1. 
Superscripts

y = a x + b x + c

Example 1: Enter an equation to illustrate the use of 
superscripts.

Enter the quadratic equation:
2

y = a x + b x + c

y
Space

Space 

a
Space 

x

0
2
Enter (Return works too, but Enter is

preferred for leaving this superscript 
level. Return returns you to the base 
line even if the cursor is nested several 
levels deep as when you are typing a 
subscript of a subscript, but Enter 
removes only one level of nesting. )

The program automatically sets the 
superscript placement and font size.

2
The screen should now contain the following: y = a x 
If not, use Backspace to remove unwanted characters. The 
Undo option on the File menu is also convenient for this 
purpose. If you become hopelessly confused while typing 
an equation, use Clear Equation on the Edit menu to start 
again with a clean screen.

Type:

Click:

Type:
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I
l  'K

y = a x + b x  + c

• Complete the equation y = ax + b x  + c 

Type: Space

+
Space

b
Space

x
Space

+
Space

c

Explore the edit commands.

• Place the I-beam cursor between the terms of the 
equation and insert additional spaces.

2
• Next select the x term by dragging.

• Press the Backspace key to delete the term.

• Undo the last deletion. (Use §€ Z or pull down the Edit 
menu, drag to Undo ,and release to restore the equation.)

2 4• Replace the x term with x

2
Select x and press Backspace again. Without moving the 
cursor

Type: x

0

4
Enter

2
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The display now contains:

Save this polynomial equation on a data disk.

• Place a data diskette in the external drive if it is not 
already there.

Recall that if a single-sided disk is in the external drive, 
equation files such as you are now creating and your word 
processor share that disk space.

• Pull down the File menu, drag to Save as..., and release 
the mouse button.

• Supply a file name (e.g., Exercise 1), and click Save or 
press Return.

You have created a MathWriter data file identified with 
the following icon:

Jxdx
Exercise 1

This file saves all equations entered and the special 
formatting and set up information required to return you 
to the present configuration. To verify this, select Clear 
Equation from the Edit menu to clear this “equation 
page”. (You can save multiple equation pages in a single 
MathWriter data file described below.)
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Saving Multiple 
Equation Pages 
in a Single 
Data File

• Select Open... from the File menu to open (or access) the 
data file you saved above.

The three dots after Open... indicate that you must supply 
additional information to complete the command. 
Specifically, you need to select the MathWriter file from 
the list presented in the window. If other MathWriter files 
were on the disk, you could scroll through the list to click- 
select the file you wanted to open.

• Select and open the file you saved (e.g., “Exercise 1”) by 
double-clicking on the file name.

The equation you saved is now on the screen.

• Make a copy of the current screen by pressing Shift S€ 3 
(i.e., while holding down the Shift and §€ keys, press the 
numeral 3).

This produces a MacPaint file containing an image of the 
screen. The program stores the file with the name “ Screen 
0” on the system disk since this is the first such snapshot. 
You can create up to ten (0,1....9) screens this way, and the 
number is automatically incremented; you must rename 
these files or place them in a folder if you wish to create 
additional screens using this technique.
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Example 2.
Adjusting 
Fraction Bars

Example 2 : Add another equation page and enter an 
equation to demonstrate subscripts and automatically 
sized fraction bars.

• Pull down the Edit menu and select Insert after. 
(Alternatively, with Option pressed, click in the large 
arrow at the bottom right comer of the screen.)

The larger scroll bar at the far right of the screen now 
displays a 2 in the scroll box indicating that the current 
display screen corresponds to equation page 2. Now enter 
an open loop transfer function (D’Azzo and Houpis 1966, 
185) from feedback control theory.

G(s) =
k 2

s2 (1 + Tf s)(l + Tm s)

• Enter the left hand side of the equation using the 
techniques of example 1.

Type: G(s) =

• Click on the fraction icon —-—i

(Note: You enter the numerator of the fraction before you 
enter the denominator.)

Type: K

0

2
Enter

Enter

(Back to the depth of K.) 
(NOT Return)
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Your equation should look like this:

G(s) = k 2

s2 (1 +Tf s)(l +Tm s)

Enter moves the cursor to the denominator, but Return 
moves the cursor back to the depth of the equals sign. Note 
that the fraction bar is drawn automatically and the 
length adjusts interactively to match the length of the 
numerator. When you enter the denominator, the program 
centers it; if the denominator length exceeds the 
numerator length, the program extends the fraction bar 
length and centers the numerator interactively.

Type: s

0
2
Enter (back to the depthof the s)

( 1 + T

0
f
Enter (back to the depth of T)

s ) ( l + T

0
m
Enter
s)
Enter

(back to depth ofT)

(back to = depth:
Return would also work)
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The screen should resemble this:

If not, use the standard edit techniques to correct 
characters on the base line as you would with the usual 
word processor techniques. To edit characters at any other 
depth you must use the arrow icon at the top left of the 
screen to obtain the “point” insertion point.

When you press the point cursor within the mathematical 
structure, the selected substructure is highlighted; when 
you release the mouse button, the insertion point is a tiny 
point to the right of the previously highlighted 
substructure.

Example 3.
Parentheses Adjust 
Automatically

Example 3: Add a third equation page and enter an 
equation to show that parentheses automatically adjust 
in size as the context requires and that an expression may 
have both subscripts and superscripts.

• Pull down the Edit menu and select Insert after.

Enter an equation from thermodynamics (Zemansky 
1968, 293)
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Type: C

0

P
Enter
Space

Space

C

v /
Enter
Space

Space

Space

T

( (from palette or keyboard)

(The parenthesis adjusts in
k size when you select the

fraction icon.)

a (from Palette menu)

V
Enter

3T
Return

) (The closing parenthesis 
also automatically adjusts 
to an appropriate size.)
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E
2
Enter

0

P (A symbol may have both a
subscript and 
a superscript.)

Return

Now the screen shows:

Cp — Cy — — T

(Note: The screen Image of the left and right parentheses 
may not appear to have the same height, but the printed 
output will be correct. This appears to be due to the screen 
font; the braces and brackets do not exhibit this quirk.
See section 27.0 of the Reference Guide (Chapter 3 ) for 
instructions to manually adjust the vertical dimension of 
certain tall characters.)

(
a.
k

dP
Enter

av
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)

0

T
Return

The screen shows:

• Click in the equation page scroll arrows to review the 
equations.

Equation scroll arrows

Equation page number

• Save the equations in a MathWriter file using Save on 
the File menu.

The program saves these equations using the default file 
name, drive, folder, etc. established in the previous Save 
as.... You can also save the currently displayed equation 
page as a MacPaint and as a MacDraw (PICT) file using the 
File menu. (However, such files can only be further 
modified using those applications. Only MathWriter data 
files which retain the complete configuration 
information may be further modified by MathWriter. You 
may save in multiple formats, however.)
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• Choose Close from the Edit menu to close this data file; 
then you can use New or Open... to begin with a new file.

• Select Quit to terminate the MathWriter session and to 
return to the Finder at the desktop.

You now see how to handle the typesetting for many of the 
equations from algebra, trigonometry, and calculus. 
Already the utility of the immediate visual display of your 
commands and the power of pointing and clicking rather 
than memorizing and typing is apparent. We suggest that 
you practice with the following equations before 
proceeding to the discussion of the more advanced features 
of the next section.

2.1.4 Practice 
examples

Test your skills with these practice problems. 

Example 4:

W  = bn + b P + b P0 g g s s

From: Cooke, J.R et al. 1976. “A finite element analysis of guard cell 
deformations". ASAE Transactions 19(6): 1107-1121.

Example 5:

c 2 2/3 1/3
f  m p 2 CR

From: Cooke. J .R  1972. “An interpretation of the resonant behavior of 
intact fruits and vegetables". ASAE Transactions 15(6): 1075-1080.
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Exam ple 6:

R = Rb+ R = ( a / D ) { T  + [ p 2ln(4/a)  + Lpp2/a -  p] }

From: Cooke, J.R. and R.H. Rand. 1980. “Diffusion resistance models" 
Ch5 in Predicting Photosynthesis fo r Ecosystem Models. Hesketh, J.D. 
and J.W. Jones (ed) CRC Press 1:93-121.

Example 7:

( a:+ a2 22 
(0 ) 2 2- ^ c o  - a 4) ( a 5 co - a 6) =

where

ai = K
a2 = M R L

a3 = [ ( |i/3) + M ] L2

a4 = S + K + [ ( (i/2) + M] g L

a5 = (7/5) M R2

a6 = M g R  + K

Use Return to begin new lines. Use horizontal tabs (See 
section 24.0 of Reference Guide) to align equals signs. Use 
the vertical tabs (section 25.0 of Reference Guide) to adjust 
the spacing between rows of equations.

From: Cooke, J. R. and RH. Rand. 1969. “Vibratory fruit harvesting: A 
linear theory of fruit-stem dynamics." Journal of Agric. Engineering 
Research 143:195-209.
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Exam ple 8:

V = [271/3] [a /  sin 0]3 [ 3 sin 0 + 3 ( 7t -  0) cos 0 -  sin30],
where

W /  H = •

'

(1 + cos 0) , 1 < W /  H < 2

(1 + cos 0 ) /  sin 0 , 0 < W / H <  1

Use the Trig menu to enter the trigonometric functions 
(section 4.0 of Reference Guide). Use the Greek alphabet at 
the bottom of the screen for 9 and n. The brace may be 
entered from the palette or keyboard and stretched to size 
(section 27.0 of Reference Guide).

From: Cooke, J. R. and R.H. Rand. 1969. “Vibratory fruit harvesting: A 
linear theory of fruit-stem dynamics." Journal of Agric. Engineering 
Research 143:195-209.

Example 9:

2 2 -  (112)x = cos0 {B + A C [1 + sin <[)][( A cos 9 ) + ( B sin 0 ) ] }

2 2 -  (1/2)y = sin 0 {A + B C [1 + sin <J>] [ ( A cos 0 ) + ( B sin 0 ) ] }

z = D cos (J)
where 0 < 0  < n / 2  , —7C/ 2  < <J) < 7t /  2

From: Cooke, J.R. et al. 1976. “A finite element analysis of guard cell 
deformations". ASAE Transactions 19(6): 1107-1121.
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Example 10:

[ (n/3) + M] L 2 0 + M L R ( p + S 0  +  K( 0  -  <|> ) + [((i/2) + M ] g L 0 = 
(7/5) M R2(p + M L R 0 + K ( c p - 0 )  + Mg R c p  = O 
(2/5) M R f  + C f  = 0

Use the Diac. menu to place the double dots for the second 
derivatives (section 6.0 of Reference Guide). Use the Raise 
and Lower options to adjust the vertical spacing.

From: Cooke, J. R  and RH. Rand. 1969. “Vibratory fruit harvesting: A 
linear theory of fruit-stem dynamics." Journal of Agric. Engineering 
Research 143:195-209.

Example 11:

^ 7  + [ D„ -  D. a Q 2cos Q. t ] y = 02 0 1  J
dt

From: From: Cooke, J. R  and RH. Rand. 1969. “Vibratory fruit 
harvesting: A linear theory of fruit-stem dynamics." Journal of Agric. 
Engineering Research 143:195-209.

Example 12:

From: Cooke, J.R and J.W. Dickens. 1971. “A centrifugal gun for 
impaction testing of seeds". ASAE Transactions 14(1): 147-155.
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Example 13:
*
r2Hr 2 2l 5 (  2 X 

, p
'

r = • -------1- r co — 1. m 7 2
 ̂ T ) _

Watch the braces, brackets, and parentheses re-size 
automatically as you enter the equation.

From: Cooke, J.R and J.W. Dickens. 1971. “A centrifugal gun for 
impaction testing of seeds". ASAE Transactions 14(1): 147-155.

Example 14:

u ( z ,t ) = T  + B exp[ i (cot -  £z)]

(i).
v (r , z ,t) = T  + A H  (x) exp[i (cot -£z)]

where (3
X

Y
N.

a ^ ( c p / a )  

V /co

(m ' c ' co ) / k'  a a a7 s

Bi

B =

(h a / k.) 

A

R .3/2

Bi

„ 1 r l  l y
C - T + p

Hp’iP) ' P i:.3/2

Td)HV/ ( P ) N.Bi

1-1

From: Scott, N.R et al. 1982. “Analysis of earth-air heat exchange". 
Lawrence Berkley Laboratoiy Report. 72 pages.
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Exam ple 15:

Use symbols with both subscripts and superscripts (Ch 3, 
section 11.0), fractions (12.0), parentheses and braces (19.0 
and 27.0), and vertical tabs (19.0).

From: Rand, R.H. et al. 1981. “Hopf bifurcation in a stomatal oscillator". 
Journal Math. Biology. 12:1-11.

Example 16:

In this practice problem you repeatedly use a symbol 3 
from the Palettes menu, so place the Math/Calculus 
symbols on the screen (5.0) and save the subscripted 
symbols in the library of scraps.(3.13, 5.0).

From: Bird, R.B. etal. 1960. Transport Phenomena. John Wiley and Sons. New York. p85.
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Use Greek alphabet (20.0), vectors and matrices (19.0), 
diacritical marks with spacing adjustment (6.0), bracket 
overhang adjustment (9.9.1), alignment of matrix rows 
(9.10), matrix centering (9.11), horizontal tabs (24.0), and 
vertical tabs (25.0).

Example 17:

From: Delwiche, M.J. and J. R. Cooke 1977. “An analytical model of the
hydraulic aspects of stomatal dynamics” Journal of Theoretical Biology. 69:113-141.
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Example 18:

Use style (9.2), vectors and matrices (19.0), horizontal tabs
(24.0) , vertical tabs (25.0), manual symbol size adjustment
(27.0) , diacritical marks (6.0), and center matrix (9.11).

A x + B x = v

where

x = e

<p_

(h + m

\
L MLR

B =

v =

MLR 7-  M R2

S + K + ( ^  + ML 

-K

• - ( f + M L ) C

-  M R  1

,) (g + i l ) -K

K + M R (g + rj )J

From: Rand, RH. and J.R  Cooke. 1970. "Vibratory fruit harvesting: A 
non-linear theory of fruit-stem dynamics". Journal of Agric. 
Engineering Research. 15(4) 347-363.
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Example 19:

Use the summation symbol (15.0). Click the summation 
icon. The program positions the cursor for the lower limit 
and reduces the font size. The lower limit can be an 
arbitrarily complex expression. Press Enter to move 
from the lower to the upper limit. Use the Palettes menu
(5.0) to enter the symbol for infinity. After entering the 
upper limit, press Enter again to type the expression for 
the terms of the series.

From: Stroshine, R.L. et al. 1985. “An analysis o f resistance to water flow 
through wheat and tall fescue leaves during pressure chamber efflux experiments" 
Plant, Cell and Environment. 8:7-18.



36 USERS GUIDE

Use the integral icon (16.0). The program automatically 
positions the cursor and reduces the font size for the lower 
and upper limits of integration. Use Enter to move from 
the lower to upper limit and from the upper limit to the 
integrand. The integral symbol size may be manually 
adjusted (27.0) This example also introduces the square 
root symbol (13.0) which the program automatically sizes.

Example 20:

Q
2 n  D CQ a

K(e)

where
F '2 d (j)

K(e) =

o

and
2

e 2a

From: Cooke. J.R. 1966. “Some theoretical considerations in stomatal 
diffusion: A field theory approach" Acta Biotheoretica. 173:95-124.
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In this example explore the use of the on-screen alphabet 
and numeral palettes (5.0). Three terms recur in the 
equation, so create them and paste them into the library 
of scraps. We used DodoniltaJic in this example. Save your 
work often when working either with new commands or 
with complex expressions (2.4, 2.5). Improve the 
appearance of the matrix expressions (9.10, 9 .11).

Exam ple 21:

From: Upadhyaya, S.K. et al. 1981. “Limb impact harvesting, Part I: 
Finite element analysis". Transactions ASAE. 24(4) 856-863.
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Exam ple 22:

The final exercise demonstrates the matrix alignment 
capabilities of MathWriter.

From: Bathe, Klaus-Jurgen. 1982. Finite Element Procedures in 
Engineering Analysis. Prentice-Hall, Inc. Englewood Cliffs. p324.



Chapter three

MathWriter™ 
Command Reference





MATHWRITER COMMAND REFERENCE 

Table of Contents

PULL-DOWN MENUS ........................................................  43

1.0 "Apple" menu .......................................................... 43
2.0 File .......................................................................... 44
3.0 Edit .........................................................................  50
4.0 Trig .......................................................................... 58
5.0 Pa le ttes ..................................................................  58
6.0 Diac ......................................................................... 62
7.0 Fonts .......................................................................  62
8.0 FontSize .................................................................. 63
9.0 Style ........................................................................  64

ON-SCREEN PALETTE ......................................................  72

10.0 Insertion Pointers ...................................................  73
11.0 Local motion: Subscripts & Superscrip ts........  73
12.0 Fraction ..................................................................  74
13.0 Square root .............................................................  75
14.0 Product .................................................................  75
15.0 Summation .............................................................  76
16.0 In tegra l..................................................................  76
17.0 Limit .......................................................................  78
18.0 Enter ....................................................................... 78
19.0 Parentheses, brackets, and b races......................  79
20.0 Greek alphabet........................................................  80
21.0 Licensee identification .......................................  81
22.0 Scroll b a rs ............................................................. 81
23.0 Rulers...................................................................... 82
24.0 Horizontal tabs ........................................................  82
25.0 Vertical tabs............................................................  83
26.0 Refresh icon ............................................................. 84
27.0 Manual override......................................................  84





COMMAND REFERENCE 43

PULL-DOWN MENUS

6  File Edit Trig Palettes Diac. Fonts FontSize Style

1.0 ft — the “Apple” menu

The first item in the # menu is always a description of the 
program you are currently using.

fibout MathW riter'"...

Key Caps 
Chooser 
Scrapbook 
Rlarm Clock 
Control Panel

We present here the version identification and copyright 
notice for MathWriter™. MathWriter emerged from a need 
to typeset the mathematics for the Macintosh and the IBM 
PC instructional finite element analysis programs 
published by Cooke Publications. J. Robert Cooke and E. 
Ted Sobel formulated the conceptual basis for Math- 
Writer™; E. Ted Sobel produced the Lisa Pascal code.

# 1
M athW riter™  1.0

Rn Intelligent Full Screen Mathem atical Editor

Concept: JR Cooke, Ted Sobel
Programm ing: Ted Sobel

© 1986 Cooke Publications 
P.0. Bom 4448 1 thaca, NY 14852

Rll rights reserved.

The remaining items on the “Apple” menu are desk 
accessories. Typical accessories include: Alarm Clock, 
Calculator, Chooser, Control Panel, Key Caps, and 
Scrapbook. You have access to these handy tools even 
while using MathWriter.
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File 2.0 File

The first five File items perform exactly the same file 
control functions they perform in MacWrite or Word. File 
controls access to the permanent mass storage provided by 
your disk drives.

Neu»
Open...
Close
S<u»u
Saue as...
Saue Equation as M acDraw  PICT doc... 
Saue Equation as MacPaint doc... 
Print...

Quit

2.1 New

Use this command to open a new untitled file. If a file is 
currently pending, you must use the third command Close 
to close it before beginning anew. After selecting Close 
you must decide whether to save the existing document if 
you have made any changes to the file. Notice that the 
New command dims when it is not usable.

2.2 Open...

This command opens an existing MathWriter file if no file 
is currently open. The ellipsis after the command 
indicates that you need to supply additional details in a 
dialog box. The standard Open... dialog box appears. Any 
MathWriter data files present on the disk are indicated as 
choices for selection. Use the standard procedures to 
select the drive which contains the file, to open a folder, 
to select the desired file  by clicking on the file name, and 
then to retrieve the file by clicking the open button.



COMMAND REFERENCE 45

Pressing Return or double clicking on the file name also 
opens the file. If a file is currently open, the Open 
command remains dimmed until you Close that file.

Saue equations in file... 

Maxw e ll 's  Equations

2.3 Close

This command closes the active window and document if 
you have made no changes since the last Saue command.

If you have made changes, MathWriter gives you an 
opportunity to save your file before the document 
disappears. When you close a file, MathWriter remains 
active and does not return you to the Finder. The Close 
command has the same effect as clicking the close box at 
the top left comer of the screen.

You can use New or Open to begin work with another 
document. To quickly leave the MathWriter application 
entirely, you can use the Quit command described below 
instead of Close.

2.4 Save

This command saves the current collection of equations 
as a MathWriter document on the currently active drive 
and folder. If you began with a New command, you must 
give the untitled document a file name via the dialog box. 
This title is displayed at the top of the screen. If you began 
with an existing file, the program replaces the earlier 
version of the file with the newer version without 
commentary. If you wish to preserve the old version as 
well as the new, use Save as ... and supply a different file
name.
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MathWriter has a unique icon to visually identify the files 
of pages of equations. Only Mathwriter can retrieve these 
files. The program stores all the formatting information 
needed to reactivate the file; if you use the special 
commands (in 2.6 and 2.7) to create MacPaint or MacDraw 
files, only those applications, not MathWriter, can further 
process their respective files as a result of the format 
changes.

MathWriter™ MV file Draw file Paint file

2.5 Save as...

This command saves the document as a MathWriter file 
after you supply the file name, drive, and possibly the 
folder name. If you have second thoughts about saving, 
choose Cancel The data you supplied becomes the default 
for the next Save command. Unlike some operating 
systems, spaces in file names are permitted. Do not use the 
colon (:), Tab, or Return keys in the file name. Clicking a 
Return key is equivalent to clicking the Save button. If 
you give the file an existing file name, you are given an 
opportunity to choose a different name or to replace the 
existing document. Use the Eject button if you wish to 
change diskettes.

2.6 Save Equation as MacDraw PICT doc...

This command saves in MacDraw PICT format only the 
mathematical equation currently being displayed not the 
entire collection of equations. The file naming and drive 
selection considerations noted for the Save as... command
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(2.5) also apply here. You can subsequently 
modify MacDraw files in MacDraw but not in MathWriter. 
If you are likely to require any subsequent equation 
modification, save the document also as a MathWriter 
file. PageMaker™ can directly open (Place) MathWriter 
equations saved in MacDraw (PICT) format.

2.7 Save Equation as MacPaint doc...

This command saves in MacPaint format only the 
mathematical equation currently being displayed, not the 
entire collection of equations. The file naming and drive 
selection considerations noted for the Save as... 
command above also apply here. You can modify 
MacPaint files later in MacPaint but not in MathWriter. 
Use this command in a two step method of delayed data 
transfer if you wish to paste an equation into another 
application too large to be simultaneously resident with 
MathWriter and Switcher. The equation will be saved at 
the top-left comer of the MacPaint screen so Show Page 
may be useful. If you are likely to require any subsequent 
equation modification in MathWriter, save the document 
also as a MathWriter file.

2.8 Print...

The Print command produces output with the 
ImageWriter and the LaserWriter. Consult your manual 
for hardware setup advice. If this is the first use of the 
output device since power-up, supply paper, activate the 
output device, and then use the Control Panel and 
Chooser options of the # menu to properly route the 
output.
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Startup procedure:

If your ImageWriter is connected to the printer port and is 
not connected via AppleTalk, click “Disconnected”. On 
the other hand, the LaserWriter must be connected via 
AppleTalk, so click “Connected” on the Control Panel of 
the ft menu.

AppleTalk 
(S) Connected 
O  Disconnected

!□! Control Panel j

Desktop Pattern

Use Chooser of the ft menu to select the output device and 
port. The LaserWriter Plus is shown selected, but a 
LaserWriter may also be used.

An ImageWriter connected to the modem port is shown 
selected.
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After preparing the printer:

Select Print... from the File menu and then select the 
equations for printing.

Select by number the equations to be printed. In this 
example three equations exist. Select by clicking the 
equation numbers or select a range of numbers by clicking 
the beginning of a range and Shift-click the ending 
number. Alternatively, click the All button to select all 
equations. The rectangles of the selected equations are 
shown inversed.

Select Equations For Printing

[ Cancel ) Lmi—) ^

Click the now-active Print button.

Equations may also be printed from the desktop using the 
Finder's Print option on the File menu, even when 
MathWriter is not currently active.

2.9 Quit

According to custom, the last File option is Quit and 
allows you to leave the application and return to the 
desktop. If you have made changes since the last file save, 
you have one last opportunity to save your document: the 
file naming and drive selection considerations noted for 
Save as... apply here.
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Edit 3.0 Edit

ESI.
Undo WZ

tu t >‘H
i: i)|)ij >:c
P u s fa  > 'l'
Clear Equation 
Select nil
Copy to Clipboard 36K
Hu to Copy

Hemoue 
Insert before 
In sert after

Ouerlay Sym bols

Show  Scrap 
Shorn Clipboard

The Edit commands provide the five text manipulation 
options available in MacWrite or Word plus many more. 
The shortcut keyboard command equivalents for Undo, 
Cut, Copy, and Paste are the same and are shown at the 
right of each command. The commands consist of a two 
key sequence; press and hold down the 3€ key located 
between the Option key and Space bar while you press the 
second key.

3.1 Undo (36 Z)

This “oops” command allows you to undo the last 
command for those actions for which the program has not 
dimmed the Undo command.

You can undo the following actions:
1. Cut
2. Backspace

a) a selected range of characters that you deleted by
a backspace

b) sequences of single-character backspaces until
you encounter another superscript/subscript 
level or until you take an action other than a 
backspace

3. Clear Equation
4. Paste
5. Remove
6. Font change for selected text
7. FontSize change for selected text
8. Style change for selected text
9. Preferences change for selected text

10. Movement of an overlay symbol up to last move
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3.2 Cut (38 X)

This command removes selected portions of the equation. 
Drag to select portions of text then Cut to remove the 
selected text. The removed text goes into the active scrap 
replacing the current contents. That text remains in the 
active scrap, and you can paste it into another equation 
until you replace it by another Cut or Copy. As with all 
Macintosh commands, designate the object to be acted 
upon before you specify the action on the object. 
Consequently, the Cut option remains dim until you 
select the text to be cut.

You can view the text cut from the document using the 
Show Scrap command below. Use the Paste command 
described below to retrieve the material cut from the 
equation. Also see the Copy to Clipboard command 
described below for transfer of data between applications 
in either TEXT or PICT form.

This command copies selected text to the active scrap. 
Select portions of text using the mouse; then use Copy to 
place a copy of the selected text in the active scrap. The 
copy remains in the scrap until you replace it with a 
subsequent Cut or Copy.

Use Paste to move the scrap contents to another location 
in the equation or into another equation. Copy, unlike 
Cut, does not remove the selected text from the original 
document.

[Use the special command Copy to Clipboard if you wish 
to copy the entire equation to the clipboard for transfer to 
another application.]

3.3 Copy (38 C)
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3.4 Paste (3€V)
[Note: Copy and Paste are adjacent.]

This command electronically pastes the contents of the 
active scrap into the current screen at the insertion point. 
Paste is enabled only when the active scrap is in use. You 
must define the insertion point or a range of selected text 
before executing the Paste command. After the program 
pastes the scrap contents, the insertion point moves to the 
end of the inserted text. When pasting into a selected range 
of text, you replace the selected text with the scrap.

3.5 Clear Equation

This command clears the entire screen, and that includes 
all parts, whether visible or not, of the current equation 
associated with the equation number shown in the larger 
scroll box at the far right. It does not affect other 
equations which you can view by using the larger scroll 
bar for equations. Note: This command even removes any 
existing Overlay symbols as well as everything except the 
horizontal tab markers associated with the equation. 
However, the equation page remains; use the Remove 
option (3.9 below) to clear and remove the page (and 
renumber all succeeding equation pages).

3.6 Select All

This command selects all entries, whether fully visible or 
not, on the entire current equation page except any text 
added using the Overlay Symbol... command below. You 
can use this command in conjunction with Cut and 
Copy. The Copy to Clipboard command below 
automatically performs the Select All function.
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3.7 Copy to Clipboard (3gK)

This command copies the entire contents of the current 
equation page to the clipboard. It automatically performs 
a Select All before the copy. Use Copy to Clipboard to 
transfer an equation to other applications such as 
MacWrite or Word. Use it in conjunction with Switcher™ 
for greater speed. Under certain conditions you may prefer 
to use the Auto Copy option described in 3.8.

Copy to Clipboard converts the equation in MathWriter 
form to the versatile Macintosh PICT format which is 
transferrable between Mac applications. Note that Copy 
to Clipboard copies parts of the equation not visible on 
the screen; it does not copy any indication of highlighting 
of selected characters (if any) or the blinking insertion 
point.

3.8 Auto Copy

Click the Auto Copy option to have the program automat
ically execute the Copy to Clipboard command when you 
leave the program via Switcher. A small check mark 
appears on the menu to indicate that this option is active. 
Click again to defeat this option.

When using MathWriter in a RAM limiting situation, 
e.g.with a word processor and Switcher on a 512K Mac or 
with WriteNow™, FullPaint™, and Switcher on a 1M Mac, 
you may choose to avoid use of this option for speed 
considerations.

3.9 Remove

Remove completely removes the equation page from the 
resident file and makes the immediately previous
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equation page, if any, the current page. After page removal 
it renumbers any higher numbered equation pages. If you 
wish to remove several equations and do not want their 
page numbers to change continually during the process, 
remove them in decreasing numerical order. The page 
numbers are relative not absolute.

3.10 Insert before

Insert bejore creates a new empty equation page and 
places it immediately before the currently displayed 
equation page. With this command and the equation 
scroll bar you can establish the storage ordering of 
equations regardless of entry order. This command may 
also be executed quickly by clicking the equation scroll 

while pressing the Option key.arrow o
3.11 Insert after

Insert after creates a new empty equation page and places 
it immediately after the currently displayed equation 
page. With this command and the equation scroll bar you 
can establish the storage ordering of equations regardless 
of entry order. As an alternative to menu access of this 
command, click n  Iwhile pressing the Option key.

3.12 Overlay Symbols

Overlay Symbols permits arbitrary placement of 
characters on the screen including superimposing
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multiple characters. You can use this command to write 
such things as the character set for APL programs and the 

symbol for closed contour integrals.

The program replaces the left panel of the screen palette 
with the tools applicable for this mode. You automatically 
enter a special input mode indicated by the tiny “point” 
cursor. Establish the insertion point by clicking.

In general, use the Overlay Symbols ONLY after 
you have completed the rest of the equation.

* 1 \
1, 
►

Add

(----- '
Show , ■—<

0.

1. 5

In this mode you can arbitrarily position characters 
including overlaying one character with another. The 
program places characters with respect to the absolute 
coordinates of the screen, and these characters do not 
change position even if you subsequently modify those on 
the underlying main screen. Therefore, use this feature for 
its special capabilities only after you have completed the 
rest of the equation. The overlay and regular screen 
composite prints as a single screen.

The overlay screen is transparent; therefore, to identify 
the special characters created on the overlay screen in 
order to make fine adjustments in character alignment, 
use the Show command.

You can reposition any individual character on the 
overlay screen with the mouse. While depressing, the
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Option key, drag individual characters to the desired 
location with the mouse.

Note: In the program’s data structures there is absolutely 
no relation between symbols on the overlay and normal 
text screens. Consequently updates in one screen do not 
automatically update the other screen also.

3 .13  Show Scrap

Show Scrap is a generalization of the Scrapbook desk 
accessory in the # menu. Because certain symbols such as 
variables with subscripts and superscripts frequently 
reappear within a single equation or within a sequence of 
equations in a derivation, construct and save such combi
nations at the outset to speed your typing. MathWriter 
provides 10 scrap files which are equivalent to 10 single 
keystroke macro commands. You have both keystroke 
and mouse command alternatives.

Keystroke 1. To place mathematical text into one of the scraps with 
the keystroke alternative, highlight the text you want to 
copy. Then copy the selected text into the designated scrap 
by simultaneously pressing the 3€ key and one of the 
numerical keys (0-9). To retrieve the text, simply set the 
insertion point using the mouse; then with the and 
Option keys simultaneously pressed, type the number 
corresponding to the scrap to be retrieved.

The Numeric palette from the Palettes menu discussed 
below gives you visual prompting. If activated, the 
numerical characters 0-9 on the palette show up in 
outline style to indicate which scraps are in use. Use the 
Show Scrap command to examine the actual contents of
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any scrap. The program outlines those numerical 
buttons located at the top of the scrap window which 
correspond to the scraps in use. Click on an outlined 
numerical button to view the associated scrap in the small 
window. Scroll bars and a re-size box enable you to view 
the entire window.

Mouse

Unless you need an added visual check to remind you of 
the contents of a specific scrap, the keystroke technique is 
probably a more convenient way to store and retrieve 
scraps than the mouse and pull-down menu.

2. To place mathematical text into one of the scraps with 
the menu alternative, first highlight the selected text. Next 
use the Show Scrap command; then click a numeric 
button at the top of the scrap window shown above to 
identify the destination of the copy of the selected text. 
Close the scrap file using either the small square close box 
at the top left comer of the scrap window or the Show 
Scrap option again.

When you wish to retrieve the stored scrap, place the 
insertion point with the cursor and select Show Scrap 
from the menu. Select an active scrap by clicking on the 
desired active scrap number shown in outline style, and 
the scrap appears in the scrap window. If this is the 
correct scrap, use the Paste command to transfer the text. 
Close the scrap file using either the square close box at the 
top left comer of the scrap window or the Hide Scrap 
option (which toggles to Show Scrap).
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Trig

P a l e t t e s

3.14 Show Clipboard

The Show Clipboard command displays the most recent 
text copied to the Clipboard from this or a previous appli
cation. You may have placed text there with Copy to the 
Clipboard or from a desk accessory. Close the Clipboard 
using the Close command from the File menu or click the 
small square close box in the upper left comer of the 
window.

4.0 Trig

Trig is a typing aid. To use Trig, with the insertion point 
already placed, drag the mouse to the desired trigono
metric or hyperbolic function name and release the mouse 
button.

Trig

s in c o s t a n

CSC s e c c o t

s in ' 1 c o s " 1 t a n " 1

a r c s i n a r c c o s a r c t a n

s i n h c o s h t a n h

s i n h " 1 c o s h " 1 t a n h " 1

5.0 Palettes

Point-and-click text entry allows you to avoid memo
rizing numerous complex keystroke combinations. As 
with the Trig menu discussed above, you can type all 
individual characters on the Palettes menu by simply 
pointing and clicking. Because some people may consider 
the symbols somewhat esoteric, we place the symbols in 
labeled groups and display the name of the symbol you 
select in the last row of the palette menu.
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You can select any symbol from the LaserWriter™ 
Symbol™ font using the mouse and possibly a modifier 
key from the keyboard. This feature dramatically 
increases the ease and speed with which you can use 
MathWriter especially if you are a novice or occasional 
user. With a single mouse click you can form the larger 
symbols that are a composite of several symbols discussed 
below.

The menu allows you to identify symbols by name and to 
select any using the mouse, but this procedure can be 
awkward and inconvenient for frequently used charac
ters. For more efficient and faster access, place on-screen 
in full view each row of grouped characters in the pull
down palette relevant to your immediate needs but pre
serve as much of the precious on-screen equation window 
as possible. Simply select a menu row by dragging the 
mouse to the row title and release the mouse button; that 
row then appears along the bottom of the working 
window, and a check appears with that name on the pull
down palette. Typical of the Macintosh user interface, 
click on the same row title to remove the check from the 
menu and to remove the copy of the character group from 
the screen.

The on-screen Alphabet and Numerals groups permit 
mouse entry of a font in addition to the Greek alphabet.
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Italic type is often used for 
mathematical equations

The Numerals also provide quick and convenient access 
to the library of scraps (section 3.13). The Alphabet panel 
also allows the program to display on screen the 
user-supplied fonts of special, non-alphabetic symbols 
(such as Millinocket in the Maine fonts by Fulton and 
Harris), thereby circumventing your need to memorize 
non-mnemonic key strokes for them. You can also use 
this feature advantageously for entry of italic alphabets 
which are commonly used in equations.

Mathematical typesetting typically involves a mixture of 
Roman and italic characters. This on-screen alphabet 
solves two problems related to this mixture: (1) avoiding 
the exaggerated Macintosh generated italic style which 
alters the visual effect of the screen by using a font such as 
DordoiuItaUc or Ithacaltalic, and (2) avoiding excessive use of the 
Font, FontSize, and Style menus. See the Appendix for 
further discussion of fonts.

You can lock the on-screen font (sections 8.0 and 9.0) by 
clicking within the Palettes panel that identifies the font 
by name. The symbol used to designate a locked disk is the 
visual reminder. When locked, these alphabetic and 
numerical characters are not affected by subsequent 
changes in the Fonts menu until unlocked again. To 
unlock just click in the name again.
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The following figure is a complete set of symbols for 
reference purposes. Selective assignment of symbols to the 
on-screen palettes avoids loss of active screen area and 
unnecessary screen scrolling.

*  File Edit Trig Palettes Diac. Fonts FontSize Style <»

The Alphabet and the Numeral groups in this palette are 
special. You can assign any font included in your system 
file to the Alphabet and Numeral categories. Use the Fonts 
menu discussed in section 7.0 to select the font. The 
underlined names correspond to the Laser printer fonts. 
Use these whenever possible if you use the LaserWriter. 
When you select Alphabet, the program adds the font name 
to the palette; and the characters of that font appear on the 
screen allowing you to click-type the entire equation. If 
you select Numeral, the program places the corresponding 
numerical characters of the same font on screen. Pressing 
the Shift key for 1 - 2 seconds causes the shifted character 
set to be displayed.
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As mentioned in the discussion of the Show Scrap 
(section 3.13), the numerals also serve a dual function. If 
you want to copy selected text to one of the scraps, select 
the text and press the 3€key. A message appears on the 
numeral banner indicating that the numerals refer to the 
scrap numbers. With the 3€key still pressed, click on any 
of the numerals (0-9) to copy the selected text to the desired 
scrap. Outlined numerals indicate which scraps already 
contain data. Simultaneously pressing the S€ and Option 
keys allows you to paste from the scraps.

Diac.

✓  None
* Graue Recent ,
' Acute Recent

Dieresis
* Circumflew Recent 
'  Tilde Recent

Macron Recent 
’ Breue Recent 

Dot Recent
* Ring Recent
" Double Rcute Recent

Rai+e >:n
Lower XL

6.0 Diac.

Place diacritical marks above letters of the alphabet with 
this command. In MathWriter when the insertion point 
immediately follows a letter, the entries on the Diac. 
menu become operational. Click the desired accent mark.

You can adjust the vertical placement of the diacritical 
mark relative to the character it modifies using Raise and 
Lower or the keystrokes 3€R and 3€L. Each use of the 
command moves the diacritical mark further.

You can construct even more complex modifiers using the 
Overlay Symbol option on the Edit menu.

Fonts 7.0 Fonts

This menu behaves in MathWriter just as it does in 
MacWrite and Word. Times™, the default, is indicated 
with a check. To change fonts highlight (select) the text 
you wish to change. Then click on the font you wish to use.

If you intend to use the LaserWriter, use the LaserWriter
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Fonts

✓ rnnei
Chicago
Geneuo
New York
Monaco
Symbol
Courier
Heluetice

F on tS ize

FontSize
6 point
7
8 
0 
10

✓a a
14
18
2<G
48

fonts; otherwise, excessive font substitution causes delays 
Unlike Word or MacWrite, MathWriter identifies the 
LaserWriter fonts with underlining. The program retains 
font information even during a cut and paste operation. 
Your Fonts menu may not match this one but will reflect 
the current collection of fonts in your system file.

8.0 FontSize

FontSize presents a list of the permissible font sizes. The 
default is 12 point. The Fonts menu outlines the 
preferred font sizes of each font for screen presentation. 
The outlined sizes correspond to the screen font sizes 
presently in the system file. You can make additions to 
the preferred list using the Font/DA Mover utility. The 
LaserWriter smoothly prints Laser fonts for even the non
preferred, generated sizes that may appear ragged on the 
screen. The LaserWriter fonts are shown underlined on the 
Fonts menu; use these whenever possible if you use the 
LaserWriter as the output device.

MathWriter automatically selects the appropriate font 
size in most instances. For example, it automatically 
reduces the font size for subscripts, superscripts, limits for 
integrals, etc. It repeatedly reduces the font size for the 
first two levels of sub or superscripting. The smallest 
permissible font size is 6 and is supported by the 
LaserWriter. If you paste text with a small font size into an 
application that does not support very small fonts, the 
program substitutes the smallest permissible size. 
MacDraw, for instance, changes to 9 point everything 
below 9 point.

Existing type in an equation may be re-sized 
automatically. Use the mouse to select the equation or
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parts of equations and then select the desired font size. If 
the equation contains multiple font sizes, the base or 
root character takes the assigned size and all other 
characters are re-sized to maintain the original size 
relationships.

S ty le

H E i n
✓ P lain XP

Bo ld KB
/to/ic X I
underline XU
CDmQODtns xo
aaaOJaiiB xs
Lengthen
Shorten

Preferences...

flllyri mail'll! m u '*  
Canter mafrlii 
Uatcaml m ad In

9.0 Style

The Style menu sets the font style and adjusts the spacing 
of the various constructs such as bracket size, subscript 
and superscript placement, spacing of the numerator and 
denominator in a fraction, and alignment of the elements 
in a matrix.

The first six entries in this menu correspond exactly to the 
first six entries in the corresponding MacWrite menu. The 
§§key equivalent use the first letter of the style name. The 
default text style is Plain but you can freely intersperse 
Bold, Italic, Underline. Outline, and Shadow 
characters. The style currently in use appears preceded by 
a check mark on the menu.

When you make changes to selected text, the program 
automatically uses the style and size of the first character 
for the replacement. Note that the Font, FontSize, and 
Style values reflect either the previous setting or, if you 
click into the text after an alphabetical character, the 
attributes of that character.

9.1 Plain (X P )

Plain is the default font style. Select Plain to undo bold , 
Italic, underline, outline, shadow, or any combination 
of these.
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9.2 Bold (86 B)

Bold changes the style selection to boldface type. You can 
use Bold simultaneously with other styles. Select Plain 
or reselect Bold to undo this type style.

9.3 I ta lic  (861)

Italic changes the style selection to italicized type. You 
can use Italic simultaneously with other styles. Select 
Plain or reselect Italic to undo this type style.

9.4 Underline (3€U)

Underline changes the style selection to underlined type 
in the same font. Select Plain or reselect Underline to 
undo this type style.

9.5 O u t lin e  (860)

Outline changes the style selection to outlined type in the 
same font. Select Plain or reselect Outline to undo this 
type style.

9.6 S h a d o w  (86 S)

Shadow changes the style selection to shadow type in the 
same font. Select Plain or reselect Shadow to undo this 
type style.

9.7 L e n g t h e n  (§6+)

Lengthen increases the spacing between characters. First 
select (highlight) the text. Then use the Lengthen 
command as many times as needed to achieve the desired
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stretching. Press the Option key in conjunction with 
Lengthen to increase only the spaces between words as is 
done with justify in a word processor. You can repetitively 
use this command as needed.

9.8 S h o r t e n  (3S -)

Shorten decreases the spacing between characters. First 
highlight the text. Then use the Shorten command as 
many times as needed to achieve the desired compression. 
Press the Option key in conjunction with Shorten to 
decrease only the spaces between words. You can 
repetitively use this command as needed.

9.9 Preferences...

Preferences... sets spacing defaults for various 
mathematical structures. Unlike the adjustment for 
diacritical marks, this command sets defaults for all 
subsequent typing not just selected text. Preferences... 
functions the same as Fonts, FontSize, and Style above by 
modifying selected text to conform to changed preferences. 
The default positions and the corresponding scroll box 
positions are shown below.

Bracket ouerhang

Preferences

E L ' L i : — ! r o

Superscript height Ell:. :■! ■ n  '.1 M 3 0“

Subscript depth ^ u r r r T T T r r n oD

Gap: OPI/SIgma w 0O  Fraction 
O  MatrlH 
<8) other

KP j’ ' 'J 1 Vj-.Vi'jV&Y:||j■': lV M 3
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9.9.1 Bracket overhang

The large parentheses, brackets, and braces are 
constructed of multiple pieces and extend vertically 
beyond the symbol they enclose. Bracket overhang sets 
the distance they extend.

Drag the scroll box or click on the scroll arrows to adjust 
the bracket overhang. The schematic to the right of the 
scroll bar shows the effect.

Before

Bracket ouerhang — n — ro
After

Bracket ouerhang PI 111 I MiW To

9.9.2 Superscript height

Superscript height adjusts the vertical placement of a 
superscript above the character with which it is 
associated.

Drag the scroll box or click on the scroll arrows to change 
the superscript height. The schematic at the right of the 
scroll bar shows the effect.

Before

Superscript height PI' M I '.S 101 oD
After

Superscript height PI'-Iff I 1:1 CH o°

9.9.3 Subscript depth

Subscript depth adjusts the vertical placement of a 
subscript below the character with which it is associated.
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Drag the scroll box or click on the scroll arrows to change 
the subscript depth. The schematic at the right of the 
scroll bar shows the effect.

Before

Subscript depth k̂ l :?:• :iil i: iftlOl 0D
After

Subscript depth 1^I »  .-iî  •'’*■  &  I I :;lijQ| 0q

9.9.4 Gap: Pi/Sigma

Gap: Pi/Sigma sets the spacing of the lower and upper 
limit with respect to the Greek Pi and Sigma used to denote 
products and summation.

Drag the appropriate scroll box or click on the scroll 
arrows to independently change the upper or lower
spacing. The schematic at the right of the scroll bar shows 
the effect.

Gap: ®  Pi/Sigma
O Fraction 
O Matria 
O Other

Gap: (•) Pi/Sigma
O Fraction 
O Matriu 
O Other

Before

After

01 - r  ■
01 V ■>. H- -rmgi

2

2

9.9.5 Gap: Fraction

Gap: Fraction sets the vertical spacing of the numerator 
and denominator with respect to the fraction bar.

Drag the appropriate scroll box or click on the scroll 
arrows to independently change the upper or lower 
spacing. The schematic at the right of the scroll bar shows 
the effect.
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Gap: OPi/Sigma
®  Fraction 
O MatriH 
O Other

Gap: OPi/Sigma
(•) Fraction 
O MatriH 
O Other

Before

9.9.6 Gap: Matrix

Gap: Matrix sets the row and column spacing for elements 
of a matrix.

Drag the appropriate scroll box or click on the scroll 
arrows to independently change the spacing of the 
columns and rows. The schematic at the right of the scroll 
bar shows the effect. Select Center, Left, or Right 
alignment of the elements of a matrix within its column.
The actual spacing is twice that shown.

9.9.7 Gap: Other

Gap: Other sets the vertical spacing above and below any 
of the other symbols not covered under the above Gap 
settings.

Drag the appropriate scroll box or click on the scroll 
arrows to independently change the upper or lower 
spacing. (Recall that you click on a vertical up or vertical 
down arrow to center justify subsequent symbols above 
or below the symbol just typed.

T p ~
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Gap Other An example of centering height before and after:

F( x, y, z ) dV J J J F( x, y, z ) dV 

V

Click on a diagonal up or diagonal down arrow to position 
left Justified superscript or subscript characters, 
respectively. Press the Enter key to leave this depth.

Drag the scroll box or click on the scroll arrows to change 
the spacing. The schematic at the right of the scroll bar 
shows the effect.

Gap: OPi/Sigma
O  Fraction 
O  Matriw 
®  Other

Gap: OPi/Sigma
O Fraction 
O Matrix 
(S) Other

Before

After

0

9 .10 Align matrix rows

Align matrix rows aligns the rows of groups of matrices 
as a unit as shown below. The matrices must be selected 
before this command can be given. If necessary, the 
bracket height may be adjusted manually as described in 
section 27.0.
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before a b' f l  31 after a b' 1 3'
1
2 CJ

12 4j 1U eJ.2 4.

9.11 Center matrix

Center m atrix centers entire selected m atrices as a unit in  

the vertical direction as  show n below.

before 1 4  7 + ft d g after 1 4 7 a d e
2 5 8 b e h 2 5 8 + b e h
3 6 9 _c f i .3 6 9 _c f i_

9.12 Descend matrix

Descend m atrix aligns entire selected m atrices as  a  unit as  

show n  below.

1 4 7 a d g after 1 4 7
2 5 8 + b e h 2 5 8
3 6 9 c f i 3 6 9

& d 
b e 
c f

g
h
i

before
+
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ON-SCREEN PALETTE

The tools and characters of the on-screen palette are 
discussed In the order (counterclockwise) they appear 
around the screen.

MathWriter Conventions:

The small “a” Indicates the first entry expression and 
the small “b” Indicates the second.

Use the E n te r  key to return to the previous depth.

Use the R etu rn  k ey  to move from the current depth to the 
original depth (0) at once or to create a new line if the 
cursor is already at depth 0, which corresponds to the 

standard word processor line. (A positive depth indicates 

a superscript relation of a symbol to its parent or root 
symbol. Similarly, a negative depth is a subscript 

relation.)

*  File Edit Trlq Palettes Dine. Fonts FontSIze Style OC>
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Use the I-beam pointer to establish the cursor at an 
insertion point or to begin text selection. This pointer 
corresponds to the familar word processor pointer. Use 
the arrow pointer for accurate placement of the “ dot” 
cursor within a mathematical structure when you need to 
edit within a structure. When you drag the point cursor 
(mouse button pressed), the substructure identified at the 
current cursor location is shown selected ( i.e.,inversed). 
The point cursor appears at the right side of the currently 
selected structure when you release the mouse button.

10.0 Insertion Pointers

t__£ 11.0 Local motion / Subscripts & 
Superscripts

y = a x + b x  + c

Out
F

Out
F

V out V:„

out
V V in

Use these commands simultaneously to move the cursor 
vertically and to reduce the font size. Use Enter (not 
Return) to restore the original depth and size.

The vertical up and down arrows center the subsequent 
input immediately above or below the previous character 
at a distance set by the Gap: Other command.

The inclined arrows move the cursor to the superscript 
and subscript position, automatically reduce the font size, 
and left justify the subsequent input.

Use the Gap: Subscript depth and Superscript height 
options in Preferences of the Style menu to set vertical 
placement
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y =
l + x 
1 - x

d , , . v du / dx — u dv / dx_ ( u / - v ) = ----------- -- -----------

Use this command to produce fractions. The small “ a” 
and “ b” remind you to enter the numerator before the 
denominator.

1) When you click the fraction icon, the dot cursor moves 
to the numerator position and the fraction bar 
automatically and interactively increases to correspond 
to the length of the numerator. You can construct an 
arbitrarily complex numerator using the other commands 
on the palette and nest fraction bars within other fraction 
bars.

2) Press Enter (not Return) when you have completed the 
numerator, and the cursor moves to the denominator 
position. As you enter the arbitrarily complex 
denominator, the program automatically and 
interactively centers it. If the denominator exceeds the 
length of the numerator, the fraction bar automatically 
and interactively increases in length; and the program 
continually centers the numerator.

3) When you have completely entered the denominator, 
terminate the formulation o f the fraction structure using 
Return (or Enter). The cursor then advances for the next 
input.

If a parenthesis, bracket, or brace precedes the fraction, 
the program automatically and retroactively adjusts in 
size the parenthesis, bracket, or brace and uses the same 
size closing parenthesis, bracket, or brace if they are typed 
on the same line. See the section on Manual override (27.0) 
and the Overlay Symbols feature (3.12) of the Edit menu 
if you need to defeat this automatic feature.

12.0 Fraction
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\  Vv/256

The square root symbol automatically and interactively 
adjusts in size as you enter an expression that can be of 
arbitrary complexity even containing other roots nested 
within it. Press Enter to complete and exit the root entiy.

You can construct cube root and other such expressions 
using the Overlay Symbols option of the Edit menu.

13.0 Square root

14.0 Product

Click this icon to produce a product symbol. The size 
automatically and interactively adjusts as necessary. The 
program automatically reduces the font size for you to 
enter the lower index of the product first.

Press Enter (not Return) to move from the lower to the 
upper index and retain the diminished font size of the 
lower index. Press Enter to finish the product symbol.

1
H z) , I Z  I <  oo

»_n
Use Option — l—  
(See section 16.0.)

to create an inline equation.

o o

1/T (z) = z exp (y z) Xn=i [ (1 + z/n) exp ( -z/n) ], I z I < °°
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15.0 Summation

Click this symbol to produce a summation symbol. The 
size automatically and interactively adjusts as necessary. 
The “ a” and “ b” symbols indicate that you enter the lower 
limit first and then the upper limit. The program 
automatically reduces the font size.

Press Enter (not Return) to move from the lower to the 
upper limit; the font size remains reduced.

Press Enter to complete the upper limit, reset the font 
size, and return to the level of entry for the terms of the 
summation.

3
Sd/n2)
n=l f

Jv (z) = ( ~ z2/4 ^

K  ! r ( V  +  K +  1 )

Use Option t to obtain a compressed inline 
summation with the limits of integration placed within 
the vertical limits of the integral symbol. (See section

16-0.) I n~=i(l/n 2)

16.0 Integral

Click this symbol to produce an integration symbol. The 
size automatically and interactively adjusts. The “ a” and 
“ b" symbols indicate that you enter the lower limit first
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and then the upper limit. The program automatically 
reduces the font size when you enter the lower limit.

Press Enter to move from the lower to the upper limit; the 
font size remains reduced.

Press Enter to complete the upper limit, reset the font 
size, and return to the level of entry for the integrand.

For an adjustable integral the integral icon must be 
clicked from the Palettes menu. To obtain an idefinite

You can create an equation using a compressed integral 
expression in which the limits of integration are centered 
above and below the integral symbol. Simply click the 
integral symbol while the Option key is pressed.

The small, non-adjustable integral sign from the Symbol 
font can be used for an in-line equation. You can paste the

in-line equation Ĵ =i <>(̂ ) dSinto the text of WriteNow.
Note: 10 point type is small and difficult to use with inline 
equations.

integral sign, press Return just after clicking the integral 
icon to circumvent the entry of the limit of integration.

Option
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Merging Equations 
with Text

lim

Enter

Note: Unlike MacWrite 4.5 and Word 1.05, the new 
WriteNow™ word processor allows you to merge with a 
line of text a MacPaint or MacDraw PICT document or 
Clipboard transferred scrap. The most immediate use of 
this capability is the after-the-fact addition of equation 
numbers. With the earlier word processors you had to 
enter the equation number as part of the display equation 
which you pasted into the word processor document. A 
special tab symbol # for equation alignment has been 
provided in MathWriter. See section 24.0 and the 
Appendix for further discussion.

To C f(x*c)dx = C  Tof (x*c)dx + f (b’ c)i " f ("-c> To

17.0 Limit

Click this icon to display the limit symbol. The program 
automatically reduces the font size and positions the 
cursor for you to enter the limit expression “ a”.

T, 1 1 1 1 , 1
m— L 2 3 4 m J

18.0 Enter

This is an on-screen mouse-click equivalent to the Enter 
key.
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( )
[ ]

{ }

j[(l+x) sini)>,exp (- x ) 
J 2tc

We show these grouping symbols in standard size. The 
program automatically and interactively adjusts the sizes 
as needed. It even adjusts them retroactively when 
subsequent input requires larger symbols. If the closing 
parenthesis occurs on the same line as the opening one, it 
matches the opening one in size.

You can individually resize the grouping symbols as 
described later in the section on Manual override.These 
symbols are also available from the keyboard.

To create a matrix enter both the opening and closing 
symbols as adjacent characters. Beginning with column 
one enter by columns the elements of the matrix.

• When you complete each element, press Enter (not 
Return) to move to the next element in that column.

19.0 Parentheses, brackets, and braces

Enter
3

( ) 2, 3 T ~
[ ] A b r A
{ } J. Robert

• After you enter the last element in a column, hold down 
the Option key as you press Enter to move the cursor to 
the top element of the next column to the right.

• After you type all elements of the matrix, then and only 
then, press Return to exit from the matrix. If you exit 
prematurely, you can use the arrow Insertion pointer to 
resume entry.

The program provides an indication of the input level in 
the rectangular area to the left of the left scroll arrow. The 
numbers appearing there show the row and the level in 
that row. This information is especially useful when you 
enter complex structures such as matrices.
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Here are some row and depth (not column) Indicator 
examples.

20.0 Greek alphabet

The on-screen point and click Greek alphabet stretches 
across the bottom of the screen. The lower case letters are 
normally visible; press the Shift key for upper case 
letters. The program gives two alternate forms of chi and 
theta following omega. This alphabet shifts immediately 
between upper and lower case.

The user-selected, on-screen alphabet display, however, 
changes only after the Shift key has been depressed more 
than about a second. The correct case is entered even if the 
screen updating has not yet appeared. (Note: The 
immediate screen updating was suppressed for speed 
considerations.)
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21.0 Licensee identification

The program identifies the licensee on the bottom line of 
the screen. We do not encumber this copyrighted program 
by copy protection. Instead we include this gentle 
reminder of the identity of the licensee of this licensed 
program. Your license prohibits the removal of this 
identification or the copyright notice. Your license and 
the copyright laws prohibit unlawful copying of this 
program.

22.0 Scrollbars

Horizontal and vertical scroll bars are adjacent to the 
screen. You can rapidly make large horizontal or vertical 
movements of the screen viewing area by dragging the 
screen scroll boxes. Clicking in the screen scroll arrows 
produces movement in small steps. Clicking the solid 
diagonal arrow at the bottom right of the screen quickly 
scrolls the equation screen to its top left or “ home” 
position.

The larger arrow at the bottom right of the screen, part of 
the right hand border of the viewing screen, is the 
equation page scroll arrow. The rectangular equation 
scroll box displays the number of the current “ equation 
page”.
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To scroll through the equations, drag the equation scroll 
box or click the mouse in the large equation scroll arrows 
at the top or bottom ends. Click in the shaded scroll bar 
above (or below) the equation page scroll box to move 
upward (downward) ten equation pages or to the extreme 
equation page.

23.0 Rulers

An inch ruler is located along the left and top sides of the 
screen. At the extreme top right is the equation scroll 
arrow. Note that the Word ruler starts at 0, rather than 1.

1. 1 . 1 . 1 . 2,  i . 4 i_ l_ 1 . 6, l , 1 ►
► □ * —

o

24.0 Horizontal tabs

E

To the immediate left of the large equation page scroll 
arrow at the extreme top-right of the screen is a supply of 
Horizontal Tabs.

One such tab, initially at the far left, is always on the 
ruler. You can take other tabs from the supply and place 
them along the ruler. These tabs are especially useful in 
aligning equations with respect to equal signs.
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H Use the # tab to align equation numbers. This tab is 
always present on the ruler and is always the right-most 
tab.

■ K , L
___

Use the remaining tab (shown at 4 on the ruler) as a guide 
for centering equations. Move this tab to the desired 
center.

Then click in the centering box above the small vertical 
screen scroll arrow. This program command produces an 
alignment pattern of vertical lines drawn vertically from 
the centering tab and of increasing line width at 
additional one inch offsets from this line.

Move the triangular tabs to interactively shift the 
equation parts. Remember that you can align and resize 
the equations even after they are pasted into another 
application such as MacWrite.

You can move all tabs as long as they do not follow the 
equation number tab, overlap an existing tab, or precede 
the first tab (initially located under the 1 on the 
horizontal ruler).

25.0 Vertical Tabs

The rectangular boxes along the left margin of the screen 
just to the right of the vertical ruler are vertical tabs. Drag 
the boxes to reposition the line(s) of an equation.
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Note: The vertical tab example was produced as a 
MacPaint document.

dx 2 aI c b m [ ''d(l+bX)l 1'2
[(«+bX)<C4dX)]’'2 <-bd)l' J L D(e-Mx) J

-1 ( 2bdx +  » d + b c ) 
--------- — uxjin  -------------------

(-bd)1'2 l  J

-  |[bd(x+bx)lU2 +  b(c+dx) 
(bd)

,bd<0

, r»o, d<o

,bd>0

Option<drag> allows partial overlapping of the equation 
lines. Use Option Shift <drag> to switch the top-to- 
bottom order of searching for overlapping.

26.0 Refresh icon

Use the broom refresh icon anytime the screen becomes 
cluttered with fragments left from repeated updating of the 
screen. Simply click here to redraw the equation on a 
clean background.

27.0 Manual Override of Automatic Symbol 
Sizing

If you need to over-ride the automatic symbol sizing of the 
program for integral, absolute value, matrix norm, 
parentheses, brackets, braces, and the divisor slash, you 
can manually adjust them.

r r

\ i . {  } ► [ ] ( )

V J
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• To stretch one of these symbols, place the selection or 
insertion point immediately to the right of the symbol. 
Then simultaneously press and hold down the three keys 
Si, Shift, and Option. The program highlights or 
inverses the symbol and a small square box or “handle” 
appears immediately above and below the highlighted 
symbol. Drag these handles to stretch the symbol. To 
return the symbol to its smallest size, click once in the 
highlighted symbol; to re-expand the symbol, click twice 
in the highlighted symbol and release the mouse button.

• To resize the font size of the text, select by dragging and 
choose the new font size. When you select text which 
begins at the base line of the equation, all of the selected 
text is rescaled; the original relative sizing of characters is 
preserved.

Note that the automatic foimatting ignores stretched 
symbols. If you stretch a symbol outside the guides for a 
particular line and then delete that symbol, that portion 
of the symbol outside the guides will remain until the 
screen is refreshed using the broom icon.
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4.0  MathWriter and Switcher

Effective use of MathWriter requires the frequent transfer 
of typeset equations to another application such as 
MacWrite. You can accomplish the transfer by storing on 
the disk individual equations in MacPaint and MacDraw 
files or by using the standard Clipboard as the exchange 
format. To use the Clipboard before the existence of 
Switcher, you would have had to transfer an equation to 
the Clipboard, quit MathWriter, activate the other 
application, and then transfer the equation from the 
Clipboard into the application.

Switcher allows you to make a more spontaneous, 
interactive transfer. If your computer has sufficient 
memory for both of your applications (for example 
MathWriter and MacWrite) to be resident at the same time, 
you can quickly transfer equations between them. Only 
one of the applications is active at once; the other is 
inactive until you use Switcher to toggle between them. We 
describe only the procedures for the use of Switcher 5.0.1 
with MathWriter. You can obtain the Switcher 
Construction Kit from your Apple dealer for more general 
instructions.

When you want to transfer an equation to MacWrite, use 
3€K or Copy to Clipboard on the pull-down Edit menu to 
copy the contents of the screen to the Clipboard. Click on 
one end of the double arrow symbol at the right extremity 
of the menu bar to switch to MacWrite. After you select 
with the cursor the insertion point in your document, use 
3€V or Paste from the Edit menu to complete the transfer.

The Write/Math Switcher document supplied with the 
400K distribution diskette assumes that you have a copy
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of MacWrite 4.5 on the disk in the external drive. You can 
also save the MacWrite document onto the disk in the 
external drive disk. With 800K drives, both MathWriter 
and the other application can reside on the internal drive.

Begin a work session as follows:

• Turn on the power switch of the Macintosh.
• Insert your working copy of MathWriter in the internal

drive.
• Insert the MacWrite disk in the external drive.
• Double click the icon of the MathWriter disk.
• Double click the Write/Math Switcher document.

The program automatically loads both applications.

Use Switcher to transfer equations as follows:

• If necessary, click on one end of the double arrow at the
top right of the screen to bring MathWriter to the 
foreground.

• Create an equation as described in Chapter Two of the
MathWriter User’s Guide.

• Transfer the equation to the Clipboard using the Copy
to Clipboard option in the Edit menu. [If the Auto 
Copy option located just below the Copy to 
Clipboard option on the Edit menu has been 
checked, the program automatically performs this 
step.)

• Hold Option down while you click on the Switcher arrow
at the top right of the screen. [Do not click on the 
shaft of the double-headed arrow as this needlessly 
brings the Switcher screen to the fore. If you 
accidentally click on the shaft, click again on one of 
the arrows. If you select Always convert Clipboard in
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the Options item of the Switcher menu. Switcher 
automatically converts the Clipboard.]

• Use the mouse to place the insertion point and then
select Paste from the Edit menu (or just use the 3€V 
keyboard equivalent).

• Click on the Switcher arrow when you wish to return to
MathWriter.

Repeat this process as often as needed.

Always exit from a Switcher session following the steps 
below. Never just turn the power off.

• Save your document for this application.
• Quit the currently active application.
• Switch to the other application.
• Save your document for this application.
• Quit the currently active application.
• Click the close box on Switcher.

You can create additional Switcher documents to 
automatically activate other applications with 
MathWriter. •

• Double-click on the Switcher icon.
• Click to select one of the four application slots.
• Select an application from the dialog box and click the

Open button.
• Repeat this process for the other application.
• Click on a Switcher arrow to make one of the

applications active.
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MathWriter requires at least 280K of memory to function 
reliably. This minimum size information is included in 
MathWriter. MathWriter makes extensive use of memory; 
if necessary, disk storage can substitute for extra memory. 
Set a preferred memory size of 512K for MathWriter when 
you configure Switcher for your application.

4 . 1  MathWriter Sample Output

This section displays an excerpt from our finite element 
analysis program using four different font combinations. 
Times and Symbol are the standards supplied with 
MathWriter. Bodoniltalic illustrates the use of italics 
commonly associated with mathematical typesetting. 
Machias is a bit-mapped screen font developed by William 
Fulton and Joe Harris (Brown University). The Princeton 
Laser Font was developed by Philip and Harvey Lam 
(Princeton University).
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Illustration Using Times and Symbol Fonts
Stresses in the elem en t are obtained from the strains and the m aterial properties.

{ c }  =  [D ] {£ }
4x1 4x4 4x1 (rows x columns)

w here [D] is  the m aterial property matrix.
T he m aterial property matrix for axisym m etric geom etries is:

n«. E(I-JX) 
^-(l+pXi'-lpJ

P

p p 
i - p  i - p  

p
r^Pt

1“ P 1-n
0 0 (1 - 2H)

2(1- p)J

(3 .2 8 )

(3 .2 9 )

T he fin ite elem en t matrix equation defin ing axisym m etric elasticity  in a 3 -nod e triangular elem en t is:

[  2 ti f  A  [B ]T [D ] [B] ]  { U }  =  { F }  (3.30)
6x6 6x1 6x1 (rows x columns)

where r is the r-coordinate of the centroid of the element and B is the shape function derivative matrix 
evaluated at the element centroid.
T he form  o f  equation 3 .3 0  m atches the form  o f  equation 3 .1 4 . N o te  that this e lem en t equation has the 
sam e d im en sion s as d o es  equation 3 .23  for the tw o-d im en sion a l C artesian coordinate sy stem s even  
though the d im ensions o f  [D ], [B ], { e } , and (o )  differ in these tw o  coordinate system s.
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Illustration Using Times, Symbol, and Bodoniltalic Fonts
Stresses in the element are obtained from the strains and the material properties.

{a} = [D] {e}
4x1 4x4 4x1 (rows x columns)

where [D]  is the material property matrix.
T he m aterial property matrix for axisym m etric geom etries is:

[D] = (l + H)(l-2p)

1 _1L_i - p l - n
p 1 p1 -p 1 -p
p p 11-p 1-p
0 0 0

o

o

o
Q-2p)2d -p)J

(3 .2 8 )

(3 .29)

T he fin ite elem en t matrix equation defin ing axisym m etric elasticity  in a 3 -nod e triangular elem en t is:

2;i r A [ B ] T [0] [ B ] ] { U }  =  {F}
J (3 .30)

6x6 6x1 6x1 (rows x  columns)
where r  is  the r-coordinate o f  the centroid o f  the elem en t and B is the shape fu nction derivative matrix  
evaluated at the elem ent centroid.

T h e form  o f  equation 3 .3 0  m atches the form  o f  equation 3 .1 4 . N o te  that this e lem en t equation has the 
sam e d im en sion s as d o es  equation 3 .2 3  for the tw o-d im en sio n a l Cartesian coord in ate sy stem s even  
though the d im ensions o f  [D],  [.B], (e), and {a} differ in these tw o coordinate system s.
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{cr} = [D] {£}

4x1 4x4 4x1 (rows x columns) (3.28)

w h e r e  [D] i s  th e  m a t e r i a l  p r o p e r t y  m a t r i x .
T h e  m a t e r i a l  p r o p e r t y  m a t r i x  f o r  a x i s y m m e t r i c  g e o m e t r ie s  is:

Illustration Using Machias and Symbol Fonts
Stresses in the element are obtained from the strains and the
material properties.

1 1» U
1 —u 1-U

U 1 M o
E(l -n) 1-U 1-U

(1+U)(1-2m) U u 1 0
l - n 1 — M

0 0 0 (1-2U)

(3.29)

T h e  f in i t e  e le m e n t  m a t r i x  e q u a t io n  d e f i n in g  a x i s y m m e t r i c  e l a s t i c i t y  
in  a 3 - n o d e  t r i a n g u l a r  e le m e n t  is:

[  2TT r  A [B ]T [D] [B] ]  {U }  = {F } (3.30)
6x6 6x1 6x1 ( r o w s  x c o lu m n s )

w h e r e  r  i s  th e  r - c o o r d i n a t e  of th e  c e n t r o id  of th e  e le m e n t  a n d  B  i s  

th e  s h a p e  f u n c t io n  d e r i v a t i v e  m a t r i x  e v a lu a t e d  a t  th e  e le m e n t  
c e n tro id .

T h e  f o r m  of e q u a t io n  3.30 m a t c h e s  th e  f o r m  of e q u a t io n  3.14. N o te  
t h a t  t h i s  e le m e n t  e q u a t io n  h a s  th e  s a m e  d im e n s i o n s  a s  does e q u a t io n  
3.23 f o r  th e  t w o - d i m e n s i o n a l  C a r t e s i a n  c o o r d in a t e  s y s t e m s  e v e n  
t h o u g h  th e  d i m e n s i o n s  of [D], [B], {e], a n d  {cr} d i f f e r  i n  th e se  t w o  
c o o r d in a t e  s y s t e m s .
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{ o }  = [D]{e} (3.28)
4x4 4x4 4x1 (rowsxcolumns;

where [ d] is the material property matrix.
The material property matrix for axisymmetric geometries is:

Illustration Using Princeton and Symbol Fonts
Stresses in the element are obtained from the strains and the material
properties.

[D] = E(1 -Ji)
(1 +±i) (1-2W

1 ___
1-p 1 -p

J L  1 J L
i - p 1 -n 
_M___
1 - ) i  1 - j i

0

1 - L -  0
1 -ll

1 0

(1 -2 p) 
2(1 -Jl)_

(3.29)

The finite element matrix equation defining axisymmetric elasticity in a 3- 
node triangular element is:

[ 2Ttr A[B]T[D][B]]{U}= {F} (3.30)

6x6 6x1 6x1

Where r is the r-coordinate of the centroid of the element and B is the shape 
function derivative matrix evaluated at the element centroid.

The form of equation 3.30 matches the form of equation 3.14. Note that this 
element equation has the same dimensions as does equation 3.23 for the two- 
dimensional Cartesian coordinate systems even though the dimensions of [D], 
[B], {e}, and {<?} differ in these two coordinate systems.
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4.2 Report of Suggestions and Problems

We have crafted this first version of MathWriter with great care, but in any application of 
this size some blemishes are inevitable. We wish to continue the refinement and exten
sion of MathWriter as a high quality, low cost tool. Your suggestions and constructive 
criticisms can speed this process. However, please send only non-proprietary suggestions 
which you are willing to have us use freely.

Name___________________________________________ Date____________________
Address_________________________________________________________________

City_________________________________ State______________ Zip.

Version (from About MathWrite)_____________________________
Hardware configuration: RAM_________K, ROM version______
Drives_____ ____________  Hard disk________________________
System version___________Finder version____________________
Printer______________ Printer resource version number _
Name of Licensee (from screen)_____________________________

Describe the new feature(s) desired.

Or

If possible, describe the problem so that we can reproduce it.

Mail to: Cooke Publications
P.O. Box 4448 
Ithaca, N Y  14852
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4 .3  Other Cooke Publications Titles

A. Applied Finite Element Analysis Series

1. MacElastic
2. MacPoisson
3. PC-Elastic
4. PC-Poisson

These are large, visually oriented programs for solving two-dimensional and axisymmetric 
problems of elasticity and processes governed by Poisson’s equation, for example, steady 
state heat conduction, electrostatics, ideal fluid flow, diffusion, and seepage. The student 
versions are limited to 300 degrees of freedom. The student version of the program and 
text book are priced for individual student ownership. The professional version allows the 
professional to use maximum available memory.

The programs feature automatic mesh generation, automatic bandwidth reduction, 
extensive graphical output, and extraordinary attention to user friendliness. These 
programs require at least 512K of RAM and dual disk drives.

B. Forthcoming educational titles

Cooke Publications plans to develop a utility program to convert MathWriter data files 
into standard TjrX source files.

Also we plan to release the Ithacaltalic™ Laser and screen fonts.

We are currently working on a course management program suitable for use with both 
small and very large courses. Both IBM PC and Macintosh versions are being developed. 
University-wide as well as individual licenses are anticipated.
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[Make a copy of this page to use as an order form.]

COOKE PUBLICATIONS LICENSE AGREEMENT AND SOFTWARE ORDER FORM 
Cooke Publications. P.O. Box 4448, Ithaca, New York 14852

Please send the software checked below. I realize that Cooke Publications is licensing, not 
selling, this software. I have the non-exclusive right to use the enclosed program. This 
urogram can only be used on a single computer. I may physically transfer the program from 
jne computer to another provided that the program is used on only one computer at a time.
I may not electronically transfer the program from one computer to another via a network. 
The only copies of the software that I may make are reasonable numbers of copies for 
backup. I may not allow copies of the software or manual to be made for others, whether or 
not sold. I further realize that Cooke Publications will personalize the software with my 
name. Multiple copy site licenses may be negotiated directly with Cooke Publications.

If I buy a “student” version of the software, it is licensed only to me; and I may not transfer 
the license to anyone else. If I buy the “professional” version of the system, I may sell or 
otherwise transfer my license to the software only if I sell all of my rights in the license and 
I do not retain any copies of the system or documentation.

For the EBM/PC* For the Apple Macintosh*

n.a. [ 1 Math Writer & text $49.95

( ] PC-Elastic Student $39.95 I 1 MacElastic Student $39.95
[ j PC-Elastic text** $19.95 [ ] MacElastic text** $19.95
[ j PC-Elastic Professional $495.00 [ 1 MacElastic Professional $495.00

[ ] PC-Poisson Student $39.95 [ 1 MacPoisson Student $39.95
[ j PC-Poisson text** $19.95 [ ] MacPoisson text** $19.95
[ j PC-Poisson Professional $495.00 [ 1 MacPoisson Professional $495.00
* All programs require at least 512 K RAM. The finite element programs should be used with two disk 

drives. The IBM PC also requires the math coprocessor.
The finite element text book is included with the professional versions but is priced separately to 

accommodate usage with university-licensed software in a laboratory.
**

[ ] Check Enclosed (N.Y. Residents include sales tax)
[ j Charge: [ ]VISA [ JMastercard #_____________________  Expires _____ /
[ j Institutional purchase order a t ta c h e d _____________________________

S i gna tur e  ___________________________________________  Date
Please print legibly
Name _________________________________________________________
A d d r e s s  ___________________________________________ _____________
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5. INDEX ________

About M athW riter 16 
Allied Linotype 43 

Alphabet 59, 80 

Apple m enu 43 

Arrow s 59, 73 

Auto copy 53 
Backup 13 

Bodoniltalic 37, 60 

Braces 31
Bracket overhand 67 

Brackets 31 

Calculus 59
Clear Equation 17, 19, 52 
Clicking 12, 13 

Close 45
Conventions 11 , 72 
Copy 51

Copy to Clipboard 4, 53 

Cursor 12, 23 

Cut 51
Diacritical 30, 62 

Distribution  d isk  14 
Dragging 12 

Drive 14, 89 
Edit 21, 50 

Enter 17, 78 
File 19, 44 
F iles

M acD raw  46 
M acPaint 47 
M athW riter 45, 46 

Finder 13

Fonts 60, 62 
Bit-m ap 92 

Bold 64, 65 
Dow nload 91 

Font size 63 

Italic 64, 65 
Ithacaltalic 60  

Laser 91 

Lengthen 65 
Outline 64, 65 
Plain  64 
Preferences 66 

Shadow  64, 65 
Shorten 66 

Size 63 
Style 64 

Underline 64, 65

Fraction 21, 74 

FullPaint 11 

Gap 68, 69 

Geometry 59 

Greek 80
Horizontal tabs 33 
ImageWriter 4, 48 
Insert after 21, 54 
Insert before 54 
Insertion point 23, 73 
Integral 36, 76 
Ithacaltalic 60 
LaserWriter 4, 48 
Library 6 

License 81

Limit 78 
Local motion 73 

Logic 59 

Lower 62, 66 

M acDraft 11 

M acD raw  4 

M achias 91, 95 

M acPaint 4 

MacWrite 4, 11 

M aster disk 14 

M atrices  

Align 38, 69, 70 
Center 71 

Descend 71 

Left align 69 

Overhang 67 

Right align 69 

Spacing 33, 83 

M enu 43
Microsoft W ord  3, 4, 11 

New 44 

Num erals 59 

Open 44 
Operators 59 

Over-ride 84 
Overlay 6
Overlay sym bols 6, 54, 62 

PageM aker 4 

Palette 56. 58, 72 
Alphabetical 37 

Num erals 37 

On-screen 37, 59 

Pu ll-dow n  32
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Parentheses 23, 31, 79 

Paste 54 

Pi 80
PICT file 4, 26 

Placem ent 66 

Pressing 12 

Princeton font 96 

Prin t
App leTalk  48 

Chooser 48 

Control Panel 48 

From  Finder desktop 49 

Im ageW riter 48 

LaserW riter 48 

Select 13
Select equations 26, 49, 81 

Preferences 33, 66 

Print 47, 49 
Product 68, 75 

Pull-dow n m enu 43, Index 
Quit 49 

Raise 62, 66 

Refresh 84 

Return 17, 19 

Remove 53 
Resize 36 

Rulers 82 

Save 45 

Save as 46 

Save equation 46, 47 

M acD raw  46 
M acPaint 47 
M athW riter 45. 46 
Screen dum p 20

Scrap library 51, 52 

Scraps 51, 52, 56 59 
Screen index back cover 
Scroll bars 81 
Select 13, 36,49 

Select All 52 
Sets 59
Show  C lipboard  58 

Show scrap 56, 57 

Sigm a 68 

Square root 75 

Stretch 84 

Subscript 8, 27 

Sum m ation 35, 76 

Superscript 17, 67 

Switcher 4, 11, 15 

Sym bol font 6, 93-96 

T abs
Centering 28 

Equation num ber 83 

Horizontal 28, 82 
Setting 82, 83 

Vertical 28 

Trig 29, 58 
Typing aids 6 

Undo 50
U ser interface 3,11 

User-selected palette 59, 61 

Vertical tabs 32, 83 

W riteNow  15 

Write-protect 14 

W YSIW YG 3



105

43
Rbout MathlDrlter™...

Key Copt 
Chooser 
Scrapbook 
Alarm Clock 
Control Panel

44

50

Open,,,
Close
Save
Saue as...
Saue Equation as MacDraw  PICT doc... 
Saue Equation as MacPaint doc... 
Print...

Quit

Undo >:z

Eut >:>i
lo p g >:c
P u s lo
Clear Equation 
Select All

>:u

Copy to Clipboard
Auto Copy

X K
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Keyboard Commands

%+
36-
36B
see
961
96K
96L
360
36 Option + 
360ption - 
36P

36R
36S
36 ShifLOptiori

36U
36V
36Z
Enter
Return

Lengthen selection (add pixel between characters) (See 36Option+] (§9.7) 
Shorten selection (delete pixel between characters) (See 36Option-] (§9.8) 
Set font style to bold (§9.2)
Cut (remove) the selection and place it in the current scrap. (§3.3)
Set font style to italic (§9.3)
Copy current equation page into the current scrap (§3.7)
Lower the diacritical mark on the character to the left of the cursor (§6.0) 
Set font style to outline (§9.5)
Lengthen selection (add pixels only between words) [See 36+] (§9.7) 
Shorten selection (delete pixels only between words) [See 36-] (§9.8) 
Change font style to plain and undo any other modifiers such as bold, 

italic, underline, outline, and shadow (§9.1)
Raise the diacritical mark on the character to the left of the cursor (§6.0) 
Set font style to shadow (§9.6)
Produce handles for manual stretching of the integral, absolute value, 

parenthesis, bracket, brace, or forward slash to the immediate left of 
the insertion point (§27.0)

Set font style to underline (§9.4)
Paste the current scrap contents at the insertion point (§3.4)
Undo last command (§3.1)
Terminate input at the current depth (See Return)
Return to the base depth for input if not at the base level; start a new 

line if cursor is already at the base level (See Enter)

36click an on-screen numeral -  Paste a selection into scrap library (§3.13, 5.0)

36Option click an outlined on-screen numeral -
Paste a library scrap at the insertion point (§3.13, 5.0)

Option click equation scroll arrow -
Insert an equation page {Insert After or Insert before) (§3.10,3.11) 

Option click on Switcher arrow -
Required to Convert Clipboard for new applications format (§4.2) 

(Not required if Auto copy is active.) (§3.8)
Option Tab Insert a tab at the current insertion point (§24.0)

Note: Used to format computer code.



The Master Key to Mathematical Typesetting
MathWriter™ is a "what you see is what you get" editor for mathematical 
typesetting distinguished by its remarkable ease of use. This powerful desktop 
publishing tool provides precision and flexibility in typesetting mathematical 
expressions. MathWriter faithfully follows the Macintosh user interface. The 
mouse and user-customized palette on the screen permit you to compose even  
most complex mathematical expressions with little use of the keyboard.
MathWriter automatically accomplishes routine tasks such as sizing and 
placement of superscripts, subscripts, parentheses, fraction bars, matrices, and 
integral and summation symbols! With this tool you can easily handle the 
mixture of fonts, font sizes, symbols, and complex placement of characters 
typical of mathematics. You can type and edit expressions of arbitrary 
complexity using "cut and paste" techniques.
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unique data files and fully supports ImageWriter and LaserWriter. Switcher™  
allows you to quickly transfer the output to other applications such as word 
processors.
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